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Beth yw digido?

Digido yw trawsnewidiad deunydd analog i ffurf ddigidol fel ei fod ar gael i’w 
ddefnyddio trwy amrywiaeth o gyfryngau. Mae digido yn y sector treftadaeth yn 
caniatáu cadwedigaeth deunyddiau ac yn cynyddu mynediad i gasgliadau drwy eu 
cyhoeddi ar y We.

Beth yw pwrpas y canllawiau hyn?

Mae'r canllaw hwn wedi ei greu fel trosolwg o'r elfennau amrywiol sy'n gwneud 
prosiect digidol. Maent yn cynnwys dewis a pharatoi deunydd casgliad, clirio 
hawlfraint, creu metadata, cyhoeddi ar y We, archifo digidol a chadwedigaeth.

Casgliad y Werin

Casgliad y Werin yw ymrwymiad Llywodraeth Cymru i ddarparu adnodd 
rhyngweithiol sy'n dathlu bywyd, treftadaeth a diwylliant Cymru.  Mae'r wefan yn 
cynnig llwyfan hygyrch ar gyfer deunydd sydd wedi’i ddigido gan ystorfeydd ac 
unigolion fel ei gilydd a chaniatáu mynediad at gasgliadau o bob rhan o Cymru.
 
www.casgliadywerincymru.co.uk
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Cyn i chi ddechrau digido mae'n werth ystyried yn ofalus pa ddeunydd sydd i’w 
ddigido gan y gall hyn effeithio ar hyd a chost y prosiect.

Dewis deunyddiau  
     
Dyma'r cam cyntaf yn y broses o greu archif ddigidol. Mae'n dynodi eitemau neu 
gasgliadau i'w digido ar sail meini prawf fel:

• Teilyngdod hanesyddol – gall eu perthnasedd a'u pwysigrwydd ddylanwadu ar y 
cyfiawnhad dros ddefnyddio adnoddau. 

• Galw – gall deunydd sy’n arbennig o boblogaidd elwa o gael ei ddigido oherwydd y 
byddai’n caniatáu iddo gael ei weld ar-lein.

• Cyflwr yr eitemau gwreiddiol – os yw'r eitemau gwreiddiol yn fregus, fe allai eu 
digido atal difrod pellach trwy leihau'r amser maent yn cael eu trin â llaw. Ar y llaw 
arall, os yw'r deunydd yn rhy fregus, efallai na all gael ei ddigido.

• Y gallu i greu delweddau – a oes gennych y gallu technegol i ddigido ac a oes 
gennych y cyfarpar angenrheidiol?

• Hawliau – a oes gennych hawl i ddigido’r deunydd ? Ni ddylid digido deunydd heb 
glirio hawliau perthynol yn gyntaf.

• Budd ariannol posibl – os mai chi sy'n berchen ar yr hawlfraint, gallai digido ddod 
ag incwm drwy argraffu neu gyhoeddi ar-lein.

• Adnoddau dynol – a oes gennych yr adnoddau angenrheidiol neu a fydd angen 
recriwtio gwirfoddolwyr neu aelodau staff newydd?

Cadw cofnod  

Yn hytrach na cheisio digido'ch casgliad cyfan a storio'r delweddau fel y cyfryw, mae'n 
syniad da i rannu'r casgliad yn setiau hydrin o tua 100 o eitemau'r un. Gallwch enwi pob 
set neu roi rhif iddo fel y dymunwch.

Offer

Bydd rhai darnau o offer yn hanfodol i unrhyw brosiect digido:

CALEDWEDD: Y darn o offer mwyaf cyffredin ar gyfer digido mewn ystorfeydd 
treftadaeth yw'r sganiwr gwely gwastad. Maent yn caniatáu digido ffotograffau, 
llythyrau a sleidiau ac hefyd tryloywluniau wrth ddefnyddio ‘addasydd tryloywluniau’ 
(transparency adapter). Mae sganwyr ar gael mewn meintiau a all ymdrin ag 
eitemau gwreiddiol A4 ac A3. Mae'n annhebyg y gall sganwyr rhad roi canlyniadau 
da felly mae'n well buddsoddi yn y sganiwr o'r safon orau y gallwch ei fforddio.

MEDDALWEDD: Mae meddalwedd rheoli delweddau'n hanfodol mewn prosiect 
digido. Y feddalwedd fwyaf cyffredin a ddefnyddir yw Adobe Photoshop sydd ar gael 
mewn nifer o wahanol fersiynau. Mae yna hefyd fersiwn cryno ar gyfer defnydd llai 
ymdrechgar o'r enw Photoshop Elements. Mae rhaglenni cod agored (open source) 
amgen fel y rhaglen GNU Image Manipulation Program (GIMP) ar gael hefyd.
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Nodau ac amcanion

Bwriad y modiwl hwn yw esbonio pwysigrwydd hawlfraint mewn llif gwaith digido ac i 
chi ddeall y prif faterion a phroblemau y gellir eu hwynebu wrth ddechrau digido 
unrhyw gasgliad.

Nid yw'r modiwl hwn yn rhoi unrhyw gyngor cyfreithiol; cyngor ydyw yn unig a dylid 
chwilio am gyngor cyfreithiol ar gyfer materion hawlfraint neu eiddo deallusol 
penodol.

Daw'r wybodaeth sydd i'w gael yma o ffynonellau amrywiol ac fe'i hatgynhyrchwyd 
gyda chaniatâd.

Bydd y modiwl yn cynnig:

1. cyflwyniad i eiddo deallusol (IPR) a hawlfraint
2. syniad o le dylai materion hawlfraint fod o fewn y llif gwaith hawlfraint
3. awgrymiadau a chyngor ar glirio hawlfraint
4. tasgau ymarferol ar ddod o hyd i berchnogion hawliau gwahanol eitemau
5. enghraifft o lif gwaith ar gyfer clirio hawliau

Beth yw eiddo deallusol?

'Mae'r term “eiddo deallusol”  yn ymdrin ag ystod o amddiffyniadau cyfreithiol  am 
bethau a grëwyd gan y meddwl dynol.' (JISC IPR Toolkit, 2009)

Mae'r rhain yn cynnwys:
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Y math o eiddo deallusol y byddwch yn fwyaf tebygol o ddod ar ei draws wrth ddigido 
deunydd hanesyddol yw hawlfraint.

Beth yw hawlfraint? 

• Mae hawlfraint yn hawl eiddo mewn mathau penodol o waith
• Mae hawlfraint yn cael ei berchen yn awtomatig pan grëir y gwaith – nid oes 

angen ei gofrestru
• Rhaid i'r gwaith fod yn gynnyrch gwreiddiol o sgil, llafur a barn gan yr awdur
• Mae'r hawlfraint yn parhau yn y gwaith am gyfnod penodedig
• Mae  hawlfraint  yn  golygu  fod  y  perchennog  yn  rheoli  defnydd  ac 

atgynhyrchiad y gwaith
• Ni all hawlfraint gael ei roi ar ffeithiau na syniadau
• Mae rhai eithriadau penodol i hawlfraint

Beth yw ‘gwaith’?

• Mae  gwaith  llenyddol  wedi'i  gyfansoddi  o  eiriau  neu  symbolau.  Nid  yw’n 
dibynnu ar ansawdd llenyddol – fe all fod yn unrhyw beth o lythyr busnes i  
nofel

• Fe all gwaith artistig fod yn 2D neu'n 3D ac fe all gynnwys testun. Eto, nid 
yw’n dibynnu ar ansawdd artistig

• Mae mapiau, siartiau a chynlluniau'n cael eu diogelu fel gweithiau artistig yn 
hytrach na gweithiau llenyddol

• Mae  nifer  o  wahanol  fathau  eraill  o  waith  gan  gynnwys  cerddoriaeth, 
gweithiau dramatig, ffilmiau a recordiadau sain

• Fe all  eitem unigol,  fel  ffilm neu ddarn o gerddoriaeth,  gael  mwy nag un 
hawlfraint

Sut ydw i'n gwybod a oes hawlfraint mewn darn o waith?

Mae llawer  o  reolau  cymhleth  ynghylch  hyd  hawlfraint.  Yn  gyffredinol  mae  oes 
hawlfraint yn 70 mlynedd wedi marwolaeth y crëwr ond mae hyn yn amrywio'n fawr 
ac mae'n rhaid ystyried pob eitem yn unigol.

Deunydd heb ei gyhoeddi

- Mae gweithiau a grëwyd cyn 1 Awst 1989 yn parhau mewn hawlfraint tan 
31 Rhagfyr 2039

 - Mae gweithiau a grëwyd ar ôl 1 Awst 1989 yn parhau mewn hawlfraint am 
70 mlynedd ar ôl marwolaeth yr awdur

Mae'r Siartiau Cyfnod Hawlfraint ar y tudalennau nesaf yn  ddefnyddiol i benderfynu 
hyd hawlfraint gwaith.

Mae'r  siartiau  hyn  yn  eiddo  Tim  Padfield,  Ymgynghorydd  Polisi  Gwybodaeth  a 
Swyddog Hawlfraint yr Archifdy Gwladol, ac maent wedi'u hatgynhyrchu yma drwy ei 
garedigrwydd.
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Pwysigrwydd hawlfraint mewn digido
Mae digido  a  chyhoeddi  deunydd  ar  y  We wedi  cymhlethu materion  hawlfraint. 
Mae'r potensial ar gyfer atgynhyrchu’r deunydd digidol ac elwa’n ariannol ohono yn 
golygu  nad  yw'r  eithriadau  arferol  ar  gyfer  archifdai  a  sefydliadau  treftadaeth 
mwyach yn gymwys mewn amgylchedd ar-lein.

Dylai hawlfraint fod yn ganolog i unrhyw brosiect digido oherwydd pan fydd sefydliad 
yn cychwyn ar y fath brosiect, mae'n gwneud gwaith cyhoeddwr.

Mae defnydd gwaharddiedig o ddeunydd hawlfraint yn cynnwys:
- copïo
- cyhoeddi
- cyfathrebu â'r cyhoedd drwy gyfryngau gwifren neu ddiwifr (gan gynnwys 

ar y Rhyngrwyd)
- arddangos (ond nid gweithiau artistig)

Hawlfraint o fewn y llif gwaith digido
Mae troseddau hawlfraint yn digwydd pan gaiff y gwaith ei gopïo. Felly, rhaid datrys 
unrhyw faterion hawlfraint  a  chael  caniatâd oddi  wrth  ddeiliaid  hawliau  ar  gyfer 
digido a chyhoeddi'r deunydd cyn ei ddigido.

Sut mae mynd ati i glirio hawlfraint
1. Neilltuwch ddigon o amser ar gyfer y broses clirio hawlfraint. Gall  gymryd 

llawer o amser.
2. Dylech edrych ar y siart ‘Cyfnod Hawlfraint’ i weld a yw’r gwaith yn debygol o 

fod dan hawlfraint.
3. Os  oes  hawlfraint  yn  y  gwaith  o  hyd  ac  mae'r  deiliad  hawliau'n  hysbys, 

dilynwch y camau sy'n dilyn:
a.  Nodwch yr hawliau y bydd angen eu clirio, ac am ba hyd y bydd angen 

yr hawliau.
b.  Cysylltwch â deiliad yr hawliau a gofynnwch am ganiatâd i 

atgynhyrchu'r deunydd, gan ddatgan yn glir y ffyrdd yr ydych yn 
bwriadu ei ddefnyddio. Dylid derbyn y caniatâd hwn yn ysgrifenedig 
cyn atgynhyrchu'r deunydd.

c.   Gellir gweld enghreifftiau o lythyrau clirio hawliau a ffurflenni  caniatâd 
ar wefan y ‘Strategic Content Alliance’ (SCA): 
http://sca.jiscinvolve.org/ipr-publications/

4. Os nad ydy deiliad yr hawliau'n hysbys, yna mae'r gwaith yn ‘waith amddifad’ 
ac mae'n rhaid defnyddio proses wahanol:
a. Ceisiwch ddod o hyd i ddeiliad yr hawliau – dylech wneud chwiliadau 

rhesymol  a  chofnodi  unrhyw  ohebiaeth  neu  dermau  chwilio  a 
ddefnyddiwyd. Gelwir hyn yn ‘gofal dyladwy’.

b.   Os dewch o hyd i'r  deiliad hawliau, yna gofynnwch am ganiatâd fel 
uchod.

c.   Os na ellir dod o hyd i ddeiliad hawliau, dylid gwneud asesiad risg er 
mwyn penderfynu'r risg o ddigido a chyhoeddi'r deunydd.

ch.  Dylid hefyd gweithredu strategaethau ‘lliniaru’ fel polisi tynnu deunydd 
oddi ar y wefan os derbynnir cwyn.
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Arddangos hawlfraint ar-lein
Dylid arddangos datganiad hawlfraint wrth ochr delweddau sy'n cael eu harddangos 
ar wefan. Dylai hwn gynnwys y symbol hawlfraint, enw deiliad yr hawliau a dyddiad 
cychwyn yr hawlfraint. Er enghraifft:

© Llyfrgell Genedlaethol Cymru (1993)

Polisïau Hawlfraint 

Polisi neu ddatganiad hawlfraint – Mae'n syniad da cynnwys datganiad am sut 
deliwyd â hawlfraint yn y broses ddigido. Dylai bwysleisio y gwnaed 'ymdrechion 
gorau' i ddarganfod deiliaid hawliau'r eitemau dan sylw. Mewn enghreifftiau lle na 
ellid dod o hyd i'r deiliad hawliau neu nad oedd yr eitem wedi'i phriodoli, mae'r 
sefydliad yn dymuno y bydd unrhyw un sydd â gwybodaeth yngl n â'r eitem ynŷ  
cysylltu â hwy. Dylai unrhyw un sy'n credu mai nhw yw deiliad yr hawliau ddilyn y 
polisi tynnu delwedd oddi ar y wefan os derbynnir cwyn (isod).

Tynnu delwedd oddi ar y wefan os derbynnir cwyn – Dyma'r drefn lle rhoir hysbysiad 
i sefydliad neu gyfundrefn y gall cynnwys anghyfreithlon, fel deunydd sy'n troseddu 
hawlfraint, gael ei arddangos ar eu gwefan. Gellir yna dileu y deunydd, a thrwy hynny 
leihau'r atebolrwydd am roi mynediad i’r cynnwys. Dylai polisi ‘tynnu delwedd oddi ar 
y wefan os derbynnir cwyn’ clir gyd-fynd â’r datganiad hawlfraint er mwyn sicrhau y 
delir gydag unrhyw gwyn yn gyflym.

*Ni ddylid gweld y rhain fel camau sy’n cynnig amddiffyniad cyfreithiol. Mae cyhoeddi 
deunydd  heb ymgynghori â'r deiliaid hawliau yn troseddu ar hawlfraint ac yn 
anghyfreithlon.

Trwyddedu 
Un o'r pryderon mwyaf wrth gyhoeddi adnoddau digidol ar y We yw y gall 
defnyddwyr eraill eu copïo a'u defnyddio heb ganiatâd deiliad yr hawlfraint. Gan ei fod 
bron yn amhosib rhwystro defnyddwyr rhag defnyddio'r adnoddau os ydynt yn 
benderfynol o wneud, un ateb yw defnyddio trwyddedau fel ffordd o adael i eraill 
wybod yn union o dan ba amodau gellir atgynhyrchu'r adnoddau digidol (e.e. yn 
anfasnachol, enwi'r trwyddedwr, ayyb).

Y budd i'r trwyddedwr yw bod pob adnodd wedi'i labelu a'i drwyddedu'n glir ac ni all 
fod unrhyw esgus am gamddefnydd. Mae trwyddedu hefyd yn lleihau amser a 
chostau gweinyddol.

Mae llawer o wahanol fathau o gynlluniau trwyddedu, a'r mwyaf adnabyddus yw'r 
'Comin Creadigol' (Creative Commons) a'r Drwydded Archif Greadigol (Creative 
Archive Licence). 

Hawliau Moesol 
Yn bodoli ynghyd â hawlfraint yn y rhan fwyaf o ddelweddau mae hawliau moesol, sef 
hawliau'r crëwr neu'r awdur fel endid. Maent yn cynnwys:
• yr hawl i gael eich adnabod fel yr awdur neu'r cyfarwyddwr
• yr hawl i wrthwynebu triniaeth ddirmygus o waith
• dim priodoli gwaith yn anghywir
• yr hawl i breifatrwydd yn ymwneud â ffotograffau a ffilmiau penodol
Mae hawliau moesol yn para cyhyd â hawlfraint, heblaw'r hawl i wrthwynebu i 
briodoli gwaith yn anghywir, sy'n para am 20 mlynedd ar ôl marwolaeth y crëwr 
neu'r awdur.
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Nodau ac amcanion 

Mae'r modiwl hwn yn rhoi cyflwyniad i fetadata technegol a metadata disgrifiadol. Ar 
ddiwedd y modiwl hwn dylech fedru cofnodi metadata technegol at bwrpasau 
cadwedigaeth ac archifo, a metadata disgrifiadol.

Beth yw metadata?

• Mae metadata'n hwyluso darganfod, yn fewnol o fewn sefydliad neu gronfa 
ddata, ac yn allanol, gan ganiatáu mynediad defnyddwyr at gasgliadau.

• Mae metadata'n aml yn cael ei ddisgrifio fel 'data am ddata'
• Fe  all  metadata  fod  yn  'gynhenid',  yn  bodoli  o  fewn  yr  adnodd  ar  ffurf 

gwybodaeth dechnegol, neu'n 'anghynhenid' neu'n 'benodol', yn cael ei greu i 
fynd gyda'r adnodd ar ffurf gwybodaeth sy'n fwy disgrifiadol.

‘Mae metadata'n allweddol er mwyn sicrhau y bydd 
adnoddau'n goroesi ac yn parhau i fod yn hygyrch yn y 
dyfodol.’ (NISO, 2004)

Pam bod angen metadata arnom?

• Heb fetadata, gall adnodd golli'i ystyr neu'i arwyddocâd ac mae gwybodaeth 
bwysig yn mynd ar goll.

• Dylid ystyried metadata o'r cychwyn mewn unrhyw lif gwaith digido ac mae 
mor hanfodol â safonau technegol mewn cynhyrchu adnodd digidol 
gwerthfawr.
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2.1: Metadata technegol

Beth yw metadata technegol?

Mae metadata technegol yn canolbwyntio ar sut y crëwyd gwrthrych digidol, ei 
fformat a’r modd y caiff ei storio ayyb. Mae metadata technegol manwl gywir yn 
helpu ystorfa i reoli gwrthrychau digidol dros amser a'u cadw'n ddefnyddiadwy yn 
ogystal â chadw cofnod o'r hawlfraint sydd yn y ddelwedd ddigidol ei hun. Mae 
deunyddiau digidol, gan gynnwys delweddau digidol, yn cael eu cyfri'n weithiau 
llenyddol gan eu bod wedi'u hadeiladu o god deuaidd (binary code). Rydym yn 
awgrymu eich bod yn cofnodi'r meysydd isod ar gyfer setiau ac eitemau unigol o 
leiaf.

MANYLION SETIAU
Enw ystorfa
Enw Adnabod Set Digidol
Staff digido
Dyddiad sganio
Lleoliad cyfredol
Lleoliad wrth gefn a 
fformat

MANYLION EITEM
Dyfais digido (gwneuthuriad 
a model)

Epson 10000XL flatbed scanner

Manylion creu y ddelwedd 
(meddalwedd a 
ddefnyddiwyd)

Epson Smart Panel

Hanes triniaeth Master files created in RGB TIFF format, opened in 
PhotoShop 7.0, converted to Apple RGB, checked for 
sharpness, rotation, skew, histogram, levels, curves and 
colour balance.

Cydraniad y meistr 300 ppi at 100%
Cywasgiad Uncompressed
Dyfnder did y meistr 24 bit
Proffiliau lliw Master file has RGB profile embedded and web file has 

sRGB profile embedded
Stribed y raddfa lwyd Macbeth Greyscale
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2.2: Metadata disgrifiadol

Beth yw metadata disgrifiadol?

- Mae metadata disgrifiadol yn caniatáu adnabod, lleoli, adalw a rheoli 
adnoddau.

- Dylai metadata ateb y cwestiynau: ‘Beth? Ble? Pwy? Pryd?’
- Dylai hefyd roi gwybodaeth sy'n caniatáu i chi ei leoli gydag adnoddau tebyg 

eraill.

Metadata ar gyfer yr oes ddigidol

Efallai eich bod yn gyfarwydd â metadata at ddibenion catalogio ac archifo ond ar 
gyfer digido metadata DISGRIFIADOL sy'n allweddol. Mae metadata disgrifiadol yn 
cyd-fynd â'r ddelwedd ddigidol ac yn darparu gwybodaeth a chyd-destun i'r 
defnyddiwr, sy'n ei wneud yn adnodd digidol, nid ffeil digidol yn unig. Y mwyaf i gyd o 
wybodaeth sy'n cael ei gynnwys mewn metadata disgrifiadol, y mwyaf defnyddiol y 
bydd fel adnodd i'r defnyddiwr.

Safonau

Dylai metadata ddefnyddio strwythur cyffredin, set o feysydd a ellir eu storio ar 
bapur, mewn taenlen, neu mewn ffeil electronig.

DUBLIN CORE yw'r safon fwyaf cyffredin ar gyfer y We a metadata disgrifiadol. 
Mae'n strwythur lled agored sy'n rhoi is-set o feysydd sy'n gadael lle i unigolion 
ddadansoddi. Mae yna bymtheg o brif feysydd: 

1. Teitl    9.  Cyhoeddwr
2. Crëwr 10.  Cyfrannwr
3. Testun  11.  Math
4. Disgrifiad 12.  Ffynhonnell         
5. Dyddiad          13.  Fformat
6. Hawliau 14.  Perthynas         
7. Rhif adnabod 15.  Iaith
8. Lleoliad          

         
Ond rydym yn ystyried y canlynol yn hanfodol:

1. Teitl – teitl ystyrlon sy'n dweud wrth y defnyddiwr beth yw'r eitem
2. Crëwr – awdur neu grëwr gwreiddiol eitem
3. Pwnc – pynciau sy’n berthnasol i gynnwys yr eitem
4. Disgrifiad – y mwyaf manwl, gorau oll!
5. Dyddiad – y dyddiad sy'n gysylltiedig ag eitem, fel arfer dyddiad creu'r 

gwreiddiol
6. Hawliau – yr holl wybodaeth yn ymwneud â materion hawliau
7. Rhif adnabod – rhif catalog / rhif derbyn
8. Lleoliad – enw'r lle sy’n cael ei gysylltu’n bennaf â'r eitem

Noder fod rhaid cynnwys rhif ffeil unigryw'r eitem hefyd. Mae hyn yn hanfodol i lynu'r 
metadata wrth y ddelwedd.

Mae mwy o wybodaeth yn yr enghreifftiau sy'n dilyn.

12



2.3: Enghreifftiau o fetadata disgrifiadol

Enghraifft 1: Ffotograff

Elfen Dublin 
Core 

Enghraifft: Ffotograff Esboniad

Enw ffeil gtj11507 Y rhif alffaniwmerig unigryw sydd wedi'i roi i'r 
ddelwedd ddigidol

Teitl Protest gyntaf Cymdeithas yr Iaith 
Gymraeg ar Bont Trefechan, 
Aberystwyth, 7 Ionawr 1963

Dylai nodi pwy, beth, ble a phryd.  Dyma'r 
wybodaeth bydd yn galluogi pobl i ddarganfod 
yr eitem felly mae'n bwysig i fod mor 
gynhwysfawr ag sy'n bosib.

Crëwr Geoff Charles Crëwr gwreiddiol yr eitem – yr 'awdur'.
Rhowch 'anhysbys' os nad ydych yn gwybod 
pwy yw'r awdur.

Pwnc
[Tagiau}

Gwrthdystiadau (LLGC), Cymdeithas 
yr Iaith Gymraeg (CT), Protest (CT), 
Iaith Gymraeg (LLGC), Cymdeithasdau 
(LLGC),

Tagiau yw geiriau sydd yn gysylltiedig gyda'r 
eitem ac maent yn cysylltu eitemau gyda'i 
gilydd ar-lein; maent yn helpu'r broses o chwilio 
am eitem. 
Gellir cael y rhain o eirfaoedd pwnc e.e. 
Llyfrgell y Gyngres neu gellir eu gwneud i ateb 
eich gofynion fel y gwelir yma. 
Dylent gael eu gwahanu gan goma.

Disgrifiad Sefydlwyd Cymdeithas yr Iaith 
Gymraeg ym mis Awst 1962 yn ystod 
Ysgol Haf Plaid Cymru ym 
Mhontarddulais. Cynhaliodd y 
gymdeithas ei phrotest swyddogol 
gyntaf ar 2 Chwefror 1963 yn 
Aberystwyth. Eisteddodd tua 40 o 
aelodau a chefnogwyr ynghanol y 
ffordd ar Bont Trefechan, gan 
rwystro'r drafnidiaeth am hanner 
awr.

Dylai hwn fod yn unrhyw wybodaeth cyd-destun 
neu gefndir i'w hychwanegu i'r eitem. Gallai 
hefyd fod yn adysgrif o destun sy'n anodd ei 
ddarllen ayyb.

Dyddiad 1963-01-07 Os nad ydych yn gwybod y dyddiad cywir yna 
dylid defnyddio'r ffurfiau sy'n dilyn:
Y ganrif agosaf: 19??-??-??
Y degawd agosaf: 191?-??-??
Ystod dyddiadau: 1939/1945
Os ydych yn gwybod rhan o ddyddiad e.e. 
Blwyddyn a mis ond dim diwrnod: 
1922-06-??

Hawliau Hawlfraint: Llyfrgell Genedlaethol 
Cymru

Yn yr enghraifft hon, LlGC sy'n berchen ar 
yr hawlfraint, dylai unrhyw wybodaeth am 
ddeiliaid hawliau ac amodau defnydd gael ei 
chynnwys yma.

Enw / Rhif 
adnabod

GCH19031 Dyma rif yr ystorfa / rhif derbyn

Lleoliad Trefechan, Cardiganshire Dylai hwn gynnwys enw'r lle ac enw'r sir cyn 
1974 (a'r wlad os nad Cymru). Dylai'r enw 
ddod o'r Gazetteer of Welsh Place-Names gan 
Elwyn Davies. 
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Enghraifft 2: Eitem amlran – Eitemau gyda sawl tudalen

Elfen Dublin 
Core

Enghraifft: Llyfr Esboniad

Enw ffeil gtj10510 Y rhif alffaniwmerig unigryw sydd wedi'i roi i'r 
ddelwedd ddigidol. Yn yr achos yma, dyma 
hefyd fyddai enw ffeil rhiant (Parent ID) y 
cyfres o dudalennau.
(Gweler esboniad i hyn islaw**)    

Teitl Llythyr wrth Daniel Horton Davies i'w 
wraig pan gafodd ei ryddhau o wersyll 
carcharorion rhyfel yn yr Almaen, 2 
Rhagfyr 1918 

Dylai nodi pwy, beth, ble a phryd.  Dyma'r 
wybodaeth bydd yn galluogi pobl i 
ddarganfod yr eitem felly mae'n bwysig i fod 
mor gynhwysfawr ag sy'n bosib.

Crëwr Daniel Horton Davies Crëwr gwreiddiol yr eitem – yr 'awdur'.
Rhowch 'anhysbys' os nad ydych yn gwybod 
pwy yw'r awdur.

Pwnc
[Tagiau]

Rhyfel Byd Cyntaf [1914-18], milwr, 
milwyr, carcharor rhyfel, gwersyll 
carcharorion rhyfel, llythyr, llythyrau, 

Tagiau yw geiriau sydd yn gysylltiedig gyda'r 
eitem ac maent yn cysylltu eitemau gyda'i 
gilydd ar-lein; maent yn helpu'r broses o 
chwilio am eitem. 
Gellir cael y rhain o eirfaoedd pwnc e.e. 
Llyfrgell y Gyngres neu gellir eu gwneud i 
ateb eich gofynion fel y gwelir yma. 
Dylent gael eu gwahanu gan goma.

Disgrifiad Mae'r llythyr yn darllen fel y canlyn: 
'My dearest Edyth I daresay you have 
received the telegram I sent 
yesterday telling you that I am free 
once more. I might be in England 
before this letter but I dont know yet 
so I am going to be on the safe side 
by sending it. We (1200 of us) left 
our camp...[yn parhau]

Dylai hwn fod yn unrhyw wybodaeth cyd-
destun neu gefndir i'w hychwanegu i'r eitem. 
Gallai hefyd fod yn adysgrif o destun sy'n 
anodd ei ddarllen ayyb.

Dyddiad 1918-12-02 Os nad ydych yn gwybod y dyddiad cywir yna 
dylid defnyddio'r ffurfiau sy'n dilyn:
Y ganrif agosaf: 19??-??-??
Y degawd agosaf: 191?-??-??
Ystod dyddiadau: 1939/1945
Os ydych yn gwybod rhan o ddyddiad e.e. 
Blwyddyn a mis ond dim diwrnod: 
1922-06-??

Hawliau Perchennog: Archifdy Ceredigion 
Crëwr: David Horton Davies

Dylid cynnwys unrhyw wybodaeth yngl n âŷ  
deiliaid hawliau ac amodau defnydd yma.
Mae'n bosib cydnabod fwy nag un hawl e.e. y 
perchennog a'r crëwr fel yn yr achos hwn.

Enw / rhif 
adnabod

CER00023 Dyma rif yr ystorfa / rhif derbyn

Lleoliad Aberystwyth, Ceredigion Dylai hwn gynnwys enw'r lle ac enw'r sir cyn 
1974 (a'r wlad os nad Cymru). Dylai'r enw 
ddod o'r Gazetteer of Welsh Place-Names 
gan Elwyn Davies. 

**Os yw’r ddelwedd mewn cwestiwn (fel yn enghraifft 2) yn rhan o gyfres o ddelweddau 
digidol, dylid cysylltu’r ddelwedd gyda’r clawr neu brif ddelwedd trwy ddefnyddio’r enwau ffeil 
yn y daenlen. Yn yr achos yma, gelwir y ddelwedd sy’n glawr yn ‘enw ffeil rhiant’ (parent ID) 
yn y daenlen ac yna mae enwau ffeil y delweddau dilynol yn cael eu cysylltu i’r enw ffeil rhiant 
gan greu trefn y tudalennau. 
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Cyflwyniad i sganio

Y ffordd hawsaf i ddigido deunydd 2D yw defnyddio sganiwr gwely gwastad. Wrth 
ddefnyddio sganiwr o safon uchel, gellir creu delweddau o ansawdd da at bwrpas 
cadwedigaeth ddigidol yn ogystal ag arddangos.

Mae yna nifer o ffactorau sy'n effeithio ar ansawdd sgan ac mae nifer o ffyrdd i 
sicrhau fod y sgan o'r ansawdd gorau posibl.

Mae'r broses o fewnbynnu'r gosodiadau hyn a'u rheoli yn cael ei adnabod fel 
'graddnodiad' (calibration).

Pam graddnodi sganiwr?

• Er mwyn sicrhau eich bod yn cael yr atgynhyrchiad gorau, cywiraf, gyda 
lliwiau cywir o'ch sgan

• Mae graddnodi'n gosod y ddyfais delweddu i raddfa ddiffiniedig, gan sicrhau 
ei fod yn rhoi canlyniadau cyson bob tro mae'n cael ei ddefnyddio

• Mae sicrhau fod y sgan gwreiddiol mor fanwl gywir â phosibl yn osgoi gorfod 
trin y ddelwedd yn ddiweddarach e.e. gydag Adobe Photoshop neu GIMP. 
Mae'n arbed amser ac yn atal afluniad (distortion) y sgan wreiddiol.

Beth yw'r ffactorau sy'n penderfynu ansawdd sgan?

• Cydraniad (resolution): Dyma nifer y picseli sy'n ffurfio delwedd ddigidol, ac 
sy'n penderfynu ei hansawdd. Mae'n cael ei fynegi mewn ppi (picseli i'r 
fodfedd) neu dpi (dotiau i'r fodfedd). Fel rheol, y mwyaf o fanylder sydd yn y 
gwrthrych gwreiddiol, yna'r uchaf y dylai'r cydraniad fod. Argymhellir y dylid 
defnyddio cydraniad o 300dpi o leiaf. Dylai hyn gynnig digon o fanylder ar 
gyfer y rhan fwyaf o ffotograffau, cardiau post, posteri a phrintiau.
Nodwch: bydd angen gostwng cydraniad y ddelwedd i'w chyhoeddi ar y We.

Dyma dabl sy’n awgrymu  cydraniadau ar gyfer creu delweddau:

Gwreiddiol Cydraniad Nodiadau
Ffotograff 300 dpi Dyma'r cydraniad isaf derbyniol
Llythyrau a celfyddyd 
llinell

600 dpi Bydd y cydraniad uwch yn 
caniatáu eglurder

Darluniau a mapiau 300 dpi Dylai'r safon isaf fod yn ddigonol 
ond efallai y bydd angen ei godi

Tryloywluniau a 
negyddion 35mm

1200 dpi Bydd angen addasydd 
tryloywluniau i sganio 
tryloywluniau neu negyddion ar 
sganiwr gwely gwastad.
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• Dyfnder lliw neu ddyfnder did (bit depth): Dyma'r term a ddefnyddir i 
ddisgrifio nifer y lliwiau a all gael eu cynrychioli'n ddigidol. Gall dyfnder ‘did’ fod 
cyn lleied â lliw 1-did sy'n arddangos dau liw – du a gwyn - i 32-did ac uwch 
sy'n arddangos biliynau o liwiau. Rydym yn argymell eich bod yn defnyddio lliw 
24-did neu 'truecolour' sy'n dynwared y byd go iawn orau, gan gynhyrchu 
dros 16.7 miliwn o liwiau.

• Cadwch y delweddau fel ffeiliau heb eu cywasgu. TIFF yw'r fformat gorau ar 
gyfer y meistr-ffeil gan ei fod:
- yn cadw'r holl wybodaeth a grëwyd gan y ddyfais digido
- yn cadw unrhyw wybodaeth rheoli lliw'r ddyfais digido
- Nid yw'n cywasgu

• Mae fformat TIFF yn cynnig ffeiliau ansawdd uchel sy'n ddelfrydol ar gyfer 
pwrpasau storio archifol

• Dechreuwch system enwi ffeiliau a storio (gweler Modiwl 6: Archifo)
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3.1 Sut i baratoi'r sganiwr

Y tro cyntaf rydych yn agor rhaglen GNU Image Manipulation Programme (GIMP) 
mae'n rhaid i chi osod y Gosodiadau Lliw (Colour Settings):

3.1.1  Lansiwch GIMP

3.1.2  Ar y bar offer top, ewch i  Edit > Preferences.  Yna yn y ffenestr sy'n 
ymddangos, dewiswch Colour management o'r rhestr opsiynau ar y chwith.

3.1.6   Yna, lansiwch feddalwedd y sganiwr. Dewiswch File > Create >   
Scanner/Camera… 

3.1.7  Yn y ffenestr sydd yn ymddangos, dewiswch eich ffynhonnell e.g. Epson   
Expression 10000XL 
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3.1.3
RGB Profile: 
Dewiswch
sRGB IEC61966-
2.1 o'r rhestr sy'n 
gollwng lawr

NODYN: Os nad yw'r 
opsiwn yma yn 
ymddangos, cliciwch 
Select colour profile 
from disk... Bydd 
ffenestr newydd yn 
ymddangos. 
Cliciwch y ffeil 
Colour ar y rhestr 
chwith.  Dewisiwch 
yr opsiwn sy'n 
dechrau gyda sRGB 
o'r prif restr.

3.1.4
File Open 
behaviour:
Dewiswch Convert 
to RGB workspace 
o'r rhestr sy'n 
gollwng lawr

3.1.5
Gwasgwch  OK 
er mwyn 
ymrwymo i'r 
newidiadau yma



Bydd y ffenestr Epson Scan yn ymddangos:
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3.1.7
Dylai'r gosodiadau 
sylfaenol gyfateb i'r rheini 
yn y diagram.

Nodwch yn benodol:

- Mode

- Image Type

- Resolution

- Unsharp mask 

HEB ei ddewis

Nodyn: 
Efallai na fydd yr opsiwn 
Unsharp mask yn 
ymddangos, ac bydd 
angen i chi sgrolio lawr 
i'w weld  

3.1.8
Sicrhewch fod 
gosodiadau 
Configuration yn 
gywir. Cliciwch ar 
Configuration i 
agor y bocs deialog 
er mwyn gwneud 
hyn.
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Tab 1 : Preview

Tab 2 : Colour

3.1.9  Sicrhewch fod y gosodiadau o dan y tri thab yn ymddangos fel y gwelwch 
yma. Dylai'r feddalwedd gadw’r gosodiadau ac felly mae'n annhebyg y bydd rhaid 
eu newid.           

Nodyn:
Sicrhewch NAD 
OES tic ar 
'continuous auto 
exposure'

Tab 3 : Other

Nodyn: 
Dylai hyn ddechrau gyda 
C:\ ond fe all gweddill y 
ffeil edrych yn wahanol yn 
eich ffenestr

3.1.10
Gwasgwch OK  i fynd yn 
ôl at ffenestr Epson 
Scan



3.2: Paratoi ar gyfer sganio casgliad o eitemau

Mae'r gosodiadau uchod yn sicrhau fod eich sganiwr yn medru creu y ddelwedd i'r 
ansawdd gofynnol. Nesaf, mae angen i chi alluogi i'ch sganiwr atgynhyrchu’r eitem 
wreiddiol mor fanwl gywir ag sy'n bosibl.

Rydym yn gwneud hyn drwy bennu gwerth lliw du a gwyn, dweud wrth y sganiwr i 
sganio o fewn y pwyntiau hynny, ac yna mesur y gwerthoedd ar ôl sganio. Mae hyn 
yn sicrhau fod y ddelwedd ddigidol mor fanwl gywir â phosibl. Defnyddir stribed y 
raddfa lwyd i wneud hyn gan ein bod yn gwybod beth yw gwerthoedd cywir y du a'r 
gwyn. Wrth osod y pwyntiau du a gwyn cyn sganio, gellir mesur stribed y raddfa 
lwyd yn Photoshop er mwyn sicrhau cywirdeb.

I wneud hyn, dilynwch y camau isod:

3.2.1   Gwnewch sgan rhagolygol (preview scan) o stribed y raddfa lwyd. Rhowch y 
stribed a'i wyneb i lawr ar wely's sganiwr a gwasgwch preview.

3.2.2.  Unwaith mae'r sgan rhagolygol wedi'i wneud, cliciwch ar y botwm 'histogram 
adjustment' yn y ffenestr Epson Scan ac mi fydd y ffenestr Histogram Adjustment 
yn ymddangos: 
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3.2.3
Cliciwch ar y dewiswr 
lliw (pipette) ar y 
chwith (ar eithaf du'r 
raddfa).  Yna yn y 
ffenestr ragolygol, 
cliciwch ar rhan du 
stribed y raddfa lwyd.

3.2.4 
Gwnewch yr un peth 
gyda'r dewiswr lliw 
ar y dde (ar ben 
gwyn y raddfa) a  
chliciwch ar ran 
gwyn stribed y 
raddfa lwyd yn y 
ffenestr ragolygol. 



3.2.5   Yn y ffenestr Histogram Adjustment, mewnbynnwch y rhifau canlynol yn y    
blychau allbwn (Output  windows ):

3.2.6   Gwasgwch close i gadw’r addasiadau yma i’r histogram

Esboniad:
Mae gwneud hyn yn penderfynu gwerthoedd y du a'r gwyn ymlaen llaw gan ganiatáu 
i ni wybod a yw'r sganiwr yn cynhyrchu cynrychiolaeth gywir o'r ddelwedd wreiddiol. 
Ffordd arall o sicrhau cywirdeb y ddelwedd ddigidol yw gwneud cyweiriad bychan i'r 
'tone curve', ac fe fydd hyn yn tynnu allan lliw a gloywder y ddelwedd wreiddiol.

Gosodiadau lliw (Tone curve correction):

    3.2.7 Cliciwch ar yr eicon ‘tone correction’ sydd wrth ymyl yr eicon 'histogram 
              adjustment' ar y ffenestr Epson Scan

 

Bydd y ffenestr hon yn ymddangos:
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Nodyn: Peidiwch newid y rhifau yn y blychau mewnbwn ( Input windows) 

Allbwn du: 25 Allbwn gwyn: 225

Nodyn: Efallai 
bydd angen i chi 
clicio ar y grid er 
mwyn gallu 
defnyddio'r bocs 
mewnbwn a 
bocs allbwn

3.2.8  
Ychwanegwch y gwerthoedd hyn 
i'r blychau:

Mewnbwn (Input) – 118

Allbwn (Output) – 140



Teipiwch enw eich prosiect yn y bocs Tone Curve Name a gwasgwch Save. 

3.2.9   Caewch y ffenestr i ddychwelyd at ffenestr Epson Scan.
3.2.10   Cadwch y gosodiadau hyn i gyd wrth wasgu Save ar frig y panel gosodiadau 
ar ffenestr Epson Scan.  Bydd y meddalwedd yn dewis enw'n awtomatig (e.e. 'Setting 
1') felly nodwch p'un yw'r gosodiad cywir.

3.3 : Sgan arbrofol
Cyn dechrau sganio'r casgliad o eitemau, mae angen i chi sicrhau fod y 
gosodiadau'n gywir:
3.3.1  Rhowch eitem ar wely'r sganiwr, gan adael tua modfedd rhwng   
stribed y raddfa lwyd a'r eitem
3.3.2  Cliciwch ‘preview’ er mwyn sicrhau bod y ddelwedd yn syth a.y.y.b.
3.3.3  Os ydych yn hapus gyda'r ddelwedd, gwasgwch SCAN
3.3.4  Unwaith mae'r sgan yn gyflawn,  fe ddylai'r delwedd ymddangos yn  
eich ffenestr Photoshop.
3.3.5  Gwnewch yn siwr eich bod yn cau ffenestr Epson Scan.  Bydd     
ffenestr Photoshop wedi rhewi tan eich bod yn gwneud hyn.  
3.3.6  I weld bod y gosodiadau'n gywir mae angen i chi wneud prawf Rheoli  
Ansawdd (Quality Control)

3.4: Prawf Rheoli Ansawdd Sylfaenol
3.4.1   Gyda'ch delwedd yn GIMP, chwyddwch allan o'r ddelwedd er mwyn sicrhau 
fod stribed y raddfa lwyd wedi cael ei ddigido ac na gollwyd unrhyw beth yn y sgan.
3.4.2   Yna chwyddwch mewn er mwyn sicrhau fod yr holl fanylder pwysig yn glir a 
heb bylu. Dylai'r print mân fod yn ddarllenadwy.

Nawr mae angen i chi wirio'r lefelau du a gwyn ar stribed y raddfa lwyd:
3.4.3  Agorwch y dewiswr lliw (tools>colour picker).
Dylai'r panel dewis lliw ymddangos yn eich panel offer:
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3.4.4
Dewiswch ‘Sample 
average’ a newidiwch 
'radius' i 5

3.4.5
Dewiswch  Pick 
only

3.4.6
Ticiwch Use info 
window 

Nodyn : Gall y teclyn chwyddo cael ei ddarganfod yn y panel offer   



3.4.7 Cliciwch y dewiswr lliw [colour picker] ar rhan gwyn stribed y raddfa lwyd. 
Bydd ffenestr yn ymddangos gyda gwybodaeth y lliw a dewiswyd.  Dylai gwerth y 
lliwiau RGB fod o fewn 15 naill ochr i'r rhifau a welir isod.  Gwnewch yr un peth 
gyda rhan du stribed y raddfa lwyd.

       

3.4.8     Os na chewch canlyniadau o fewn 15 naill ochr i'r rhifau uchod, ma 
gosodiadau'r sganiwr yn anghywir ac mae angen i chi baratoi'r sganiwr eto 
(Gweler Modiwl 3: Paratoi). 
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White value:
 R: 235
 G: 235
 B: 235

Black value:
 R: 35
  G: 35
  B: 35

Enghraifft 
Gwyn

Enghraifft 
Du



4.1: Scanio set neu gasgliad

Yn gyntaf, crëwch ffolder newydd i storio'r delweddau ar ôl eu sganio, e.e. 
‘master_images’ neu ‘postcard_collection_masters’. 

4.1.1   Agorwch GIMP, dewiswch File> Create >Scanner/Camera…
4.1.2  Pan fydd ffenestr Epson Scan yn lansio, sicrhewch mai'r gosodiad sydd wedi'i 
ddewis yw'r gosodiadau rydych eisioes wedi'u storio.
4.1.3   Rhowch yr eitem sydd i'w sganio ar wely'r sganiwr ochr yn ochr â stribed y 
raddfa lwyd a chliciwch preview.
4.1.4   Os ydych yn hapus gyda'r ddelwedd ragolygol, gwasgwch scan.
4.1.5   Unwaith mae'r sgan wedi'i gwblhau, caewch y ffenestr Epson Scan ac fe 
ddylai'r ddelwedd ymddangos yn y ffenestr GIMP

4.1.6  Dilynwch gamau'r broses Rheoli Ansawdd sylfaenol a amlinellwyd uchod 
(adran 3.4).

Os ydych yn hapus gydag ansawdd y sgan, storiwch y ddelwedd fel dangosir isod 
(adran 4.2).

4.2: Storio'r ddelwedd wedi'i sganio – Meistrffeiliau

4.2.1  Yn GIMP dewiswch File > Export . . . 
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Pan mae'r ffenestr 'Export Image' yn ymddangos, gwnewch 
y newidiadau canlynol : 

Efallai bydd y ffenestr yma yn ymddangos: 
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4.2.4
Ehangwch file 
type selection 
drwy clicio 
arno

4.2.5
Dewiswch 
fformat TIFF 

4.2.6
Gwasgwch 
Export.

4.2.3
Dewiswch y 
folder 
priodol e.e. 
‘masters’.

Nodyn :
Mae hwn yn ddelwedd meistr – nid yw wedi’i newid mewn unrhyw fodd. Dylid ei gadw ar gyfer 
archifo. 

4.2.7
Gwnewch yn 
siwr fod None 
wedi ei ddewis

4.2.8 Gwasgwch Export

4.2.9 I sganio'r eitem nesaf, dychwelwch i adran 4.1.2

4.2.2
Sicrhewch fod gan y 
ddelwedd enw ffeil unigryw.  

Awgrym: Defnyddiwch enw 
ffeil alffaniwmerig unigryw o 
3 llythyren a 5 rhif 



4.2.10  Er mwyn cau ffenestr y delwedd yma yn GIMP, ewch i File > Close

Bydd y ffenestr yma yn ymddangos :

4.2.12  Er mwyn sganio'r eitem nesaf, ailadroddwch y broses o adran 4.1.1 
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4.2.11
Gwasgwch Close 
without Saving

(rydych eisioes 
wedi storio copi i'w 
cadw)



Nodau ac amcanion

Fe fydd y modiwl hwn yn dangos sut mae paratoi delweddau digidol i'w harddangos 
ar y We. Fe fydd yn:

- Esbonio egwyddorion arddangos ar y We
- Rhoi canllaw paratoi delweddau ar gyfer y We gan ddefnyddio meddalwedd 

Adobe Photoshop, Adobe Photoshop Elements neu GIMP 
- Rhoi cyflwyniad i lwytho deunydd i wefan Casgliad y Werin

Pam bod angen paratoi delweddau ar gyfer y We?

Mae'r delweddau gwreiddiol neu'r 'meistr' sydd gennych wedi'u sganio gyda 
chydraniad (resolution) o 300dpi ac wedi'u storio ar ffurf TIFF. Mae hyn yn golygu eu 
bod yn ffeiliau mawr iawn o safon uchel sy'n anaddas ar gyfer y We.

Er mwyn eu harddangos ar y We, mae angen i ddelweddau fod:
- O gydraniad is, argymhellir 72dpi fel arfer
- Llai o faint
- Ffeil wedi'i gywasgu, JPEG fel arfer

Caiff y newidiadau hyn eu gwneud drwy ddefnyddio meddalwedd fel Adobe 
Photoshop neu GIMP. Mae'r delweddau sy'n barod ar gyfer y We'n cael eu storio 
mewn ffeil ar wahân gyda'r un enw ffeil â'r ddelwedd meistr.

Storio'r delweddau

Bydd angen storio'ch delweddau sy'n barod ar gyfer y We mewn ffolder ar wahân 
ond byddant yn cadw'r un enwau ffeil. Crëwch ffolder i storio'ch delweddau i'w 
harddangos ar y we.
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5.1: Paratoi delweddau i’w harddangos ar y We

5.1.1  Agorwch GIMP.
5.1.2  Ewch i File > Open.  Agorwch y ffolder lle mae eich delweddau meistr wedi eu 
storio a dewiswch y ddelwedd rydych am ei olygu.  
5.1.3  Os bod angen cylchdroi'r delwedd, ewch i  Image > Transform a dewiswch y 
cylchdro priodol e.e. Rotate 90o clockwise.
5.1.4  Os bod angen sythu'r delwedd, dewiswch yr eicon sythu o'r panel offer :  
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5.1.5 Ar ôl clicio ar y llun mae gennych 
ddewis i sythu'r delwedd naill ai drwy :

a) defnyddio'r rhicyn ar y ffenestr Rotate 
NEU
b) clicio ar y delwedd ei hun i'w droi o 
gwmpas y pwynt colyn canolog

 5.1.6
Pan fyddwch yn hapus 
fod y ddelwedd yn syth, 
gwasgwch Rotate



5.1.7.  Mae angen i chi gropio eich delwedd i gael gwared â stribed y raddfa lwyd. 
Gwnewch hyd drwy ddewis yr eicon cropio o'r panel offer :
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5.1.8
Ar ôl creu blwch cropio 
o gwmpas y ddelwedd 
gallwch naill ai : 

a) Ymrwymo i gropio 
drwy glicio ar y 
ddelwedd

NEU

b) Clicio i ffwrdd o'r 
ddelwedd i ddadwneud 
y blwch cropio



6.1.9  Pan fyddwch yn hapus gyda'r delwedd, ewch i Image > Scale Image . . .

Bydd y ffenestr yma yn ymddangos:

5.1.13  Er mwyn storio'r delwedd, ewch i File > Export . . .

Bydd y ffenestr yma yn ymddangos :

.
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5.1.10
Image Size:
Newidwch 
maint ochr 
hiraf y delwedd 
i 1000 picsel

5.1.11
Resolution: 
Newidwch i 
72

5.1.12
Gwasgwch 
Scale

5.1.14
Cadwch yr un enw 
ffeil a'r delwedd 
meistr

5.1.15
Dewiswch y 
ffolder priodol i 
storio'r delwedd 
e.e. webready

5.1.16
Agorwch file 
type selection 
drwy clicio 
arno

5.1.17
Dewiswch 
fformat  JPEG 

5.1.18
Gwasgwch 
Export.



Efallai bydd y ffenestr yma yn ymddangos :

5.1.21  Er mwyn cau ffenestr y delwedd yma yn GIMP, ewch i File > Close

Bydd y ffenestr yma yn ymddangos :
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5.1.19
Gwnewch yn siwr 
fod quality yn 50

5.1.20
Gwasgwch Export

5.1.22
Gwasgwch Close 
without Saving

(rydych eisioes 
wedi storio copi i'w 
cadw)



Dyma rhai o'r mesurau syml y gallech weithredu i sicrhau safon uchel o 
gadwedigaeth ddigidol.

6.1   Rhowch enw a ffeiliwch yn briodol
6.1.1  Cadwch enwau ffeiliau'n fyr ond yn ystyrlon (e.e. canllaw_digido.doc).
6.1.2 Dylid osgoi defnyddio geiriau cyffredin ar ddechrau enw ffeil, rhowch hwy ar y 

diwedd (e.e. cynllun_digido_v3_terfynol.doc).
6.1.3 Peidiwch â defnyddio priflythrennau gan y gall hyn achosi problemau wrth 

symud ffeiliau rhwng gwahanol amgylcheddau cyfrifiadurol. Tanlinellwch yn 
hytrach na gadael gofod (e.e. canllaw_sganio.doc).

6.1.4 Pan rydych yn cynnwys rhif mewn enw ffeil, rhowch ddau ffigur bob tro er 
mwyn cadw'r drefn rifol. Mae gwneud hyn yn helpu i ddod o hyd i'r cofnod rhif 
diweddaraf (e.e. cn_01.pdf). 

6.1.5  Os ydych yn defnyddio dyddiad mewn enw ffeil, rhowch ef ar ffurf 
BBBBMMDD (e.e. 20090701_papur-a.doc).

6.1.6  Os ydych yn defnyddio enw o fewn enw ffeil, yna rhowch enw'r teulu yn 
gyntaf ac wedyn yr ynyd (e.e. jones-s.doc).

6.1.7 Trefnwch yr elfennau sydd mewn enw ffeil yn y ffordd fwyaf priodol ar  
gyfer dod o hyd iddynt eto.

6.1.8 Sefydlwch system rheoli fersiynau (e.e. cynllun_gweith2009-
2010v3drafft.doc,  cynllun_gweith2009-2010v4terfynol.doc).

6.1.9 Sicrhewch fod angen cyfrinair er mwyn cael mynediad at ffeiliau.

6.2  Ffeiliau wrth gefn
6.2.1 Mae disgiau caled yn methu, felly lluniwch drefn gopïo wrth gefn syml, 

penderfynwch beth ddylid ei gadw, a gwiriwch gopïau wrth gefn yn flynyddol.
6.2.2 Gwnewch gopïau ar weinyddwyr, mewn celloedd ar-lein neu ar gyfryngau 

symudadwy fel cofau allanol, CD a DVD.
6.2.3 Storiwch o leiaf un copi y tu allan i'r safle a dau ar y safle mewn gwahanol 

fformatau.

6.3 Gofalwch am eich caledwedd a'ch meddalwedd
6.3.1 Newidiwch eich caledwedd cyn iddo fethu drwy sefydlu cylchred caledwedd 

5 mlynedd.
6.3.2 Dewisiwch fformatau syml y gellir eu cefnogi gan nifer o gymwysiadau ac 

ystyriwch ddefnyddio meddalwedd cod agored.
6.3.3 Cadwch ddelweddau meistr safon uchel (o leiaf 300dpi) mewn fformat 

TIFF.

6.4  Rheolwch eich systemau
6.4.1 Sicrhewch fod ffeiliau wrth gefn cyn diweddaru caledwedd neu 

feddalwedd.
6.4.2 Sicrhewch fod gennych feddalwedd wrth-feirws wedi'i llwytho (e.e. AVG) a'i 

bod yn cael ei diweddaru'n rheolaidd.

6.5   Cadwch olwg ar y datblygiadau diweddaraf
6.5.1  Cadwch mewn cysylltiad ag archifwyr digidol a all esbonio'r datblygiadau 
diweddaraf ym maes cadwedigaeth ddigidol e.e. Llyfrgell Genedlaethol Cymru.
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Picsel
Y picsel (elfen llun) yw'r eitem leiaf o wybodaeth mewn delwedd 
ddigidol, fel arfer dot bach iawn. Mae pob picsel yn gynrychioliad 
digidol o ran o'r ddelwedd wreiddiol – mae mwy o bicseli fel arfer yn 
cynnig cynrychiolaethau mwy cywir o'r ddelwedd wreiddiol. Felly, y 
mwyaf o bicseli i'r fodfedd (ppi) y mwyaf clir fydd y ddelwedd, sy'n cael 
ei alw'n gydraniad (resolution).

Meddalwedd
Term cyffredinol i ddisgrifio gwahanol raglenni sy'n cael eu defnyddio i 
yrru cyfrifiaduron a chyfarpar perthynol.

Stribed y raddfa lwyd 

Mae stribed y raddfa lwyd yn stribyn o donau graddedig. Defnyddir y darn i wirio 
safon y sgan neu ffotograff digidol. Mae'n ffordd gyflym a hawdd i weld a yw'r 
sganiwr wedi cael ei raddnodi'n gywir. 

Graddnodi sganiwr (scanner calibration)
Mae graddnodi sganiwr yn sicrhau y bydd eich delwedd sydd wedi'i sganio'n 
ymddangos yn iawn ar y sgrin ac mewn argraffiadau. Mae graddnodi sganiwr yn 
gwirio ac yn cywiro'r lliwiau y mae'r sganiwr yn ei weld yn erbyn yr hyn sydd ar y 
ddogfen mewn gwirionedd. Dylid graddnodi sganiwr ar gyfartaledd bob 1,000 sgan. 
Er mwyn gosod, gwirio neu gywiro graddnodau sganiwr gweler sut i raddnodi'r 
sganiwr.

Sganio lliw
Yn defnyddio didau lluosol ymhob picsel i gynrychioli lliw, gelwir 24-did y picsel yn 
lefel lliw gwirioneddol (truecolour level), ac mae'n bosibl cael dewis o 16.7 miliwn o 
liwiau.

Dyfnder did (bit depth)
Dyma’r mesur ar gyfer nifer y didau a ddefnyddir i ddiffinio picsel. Defnyddir y term i 
ddisgrifio'r nifer o liwiau y gellir eu dangos yn ddigidol. Mae dyfnder did yn ymestyn o 
lliw-1 did sy'n arddangos dau liw – du a gwyn - i 32-did ac uwch sy'n arddangos 
biliynau o liwiau. Rydym yn argymell eich bod yn dal delweddau wrth ddefnyddio lliw 
24-did (24-bit colour) neu 'truecolour' sy'n dynwared y byd go iawn orau, gan 
gynhyrchu dros 16.7 miliwn lliw.

Lliw 24-did (24-bit colour): Mae delweddau 24-did wedi'u gwneud o dair sianel liw 8-
did. Mae sianel 8-did yn cynnwys 256 lliw. Pan maent wedi'u cyfuno, mae'r sianeli 
coch, gwyrdd a glas yn cynnig hyd at 16.7 miliwn o liwiau (h.y. 256x256x256). Mae 
lliw 24-did hefyd yn cael ei alw'n 'True Colour' a 'Photo-realistic Colour'.
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Lliw 32-did (32-bit colour): 
Mae gan ddelweddau lliw 32-did 4 sianel liw o 8 did yr un – un sianel yr un ar gyfer 
coch, gwyrdd a glas, a hefyd 8 did o ddata 'greyscale' i roi manylder gwell.

Cydraniad (resolution)
Mae cydraniad delwedd yn disgrifio'r manylder sy'n cael ei ddal yn y ddelwedd. Mae nifer y 
picseli mewn ffotograff digidol fel arfer yn cael ei alw ei gydraniad delwedd.

Cywasgiad
Mae cywasgiad yn cael ei ddefnyddio i leihau maint ffeil. Mae fformatau ffeiliau 
wedi'u cywasgu'n cynnwys jpeg a gif. 

Rheoli Ansawdd
Mae rheoli ansawdd yn gam pwysog yn y broses ddigido er mwyn gwarantu cywirdeb a 
chysondeb y ddelwedd ddigidol.

Alffaniwmerig
Casgliad o nodau wedi'u gwneud o lythrennau a rhifau yw Alffaniwmerig. 
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GWYBODAETH CYNLLUN DIGIDO
Enw/Rhif Adnabod Cynllun 
Digido
Teitl

Dyddiad Cychwyn Dyddiad Gorffen

Sefydliad

Rheolwr Cynllun Digido a 
manylion cyswllt

Partneriaid Sefydliadau eraill

Gwirfoddolwyr

Darparwyr Addysg

ENW’R DDOGFEN
Teitl y Ddogfen

Awdur a rôl

Dyddiad Enw Ffeil

HANES Y DDOGFEN
Fersiwn Dyddiad Sylwadau
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TROSOLWG O’R CYNLLUN

1.  Cefndir

2. Nodau ac amcanion

3. Ymdriniaeth gyffredinol

4. Cynnyrch y Cynllun

5. Canlyniadau’r Cynllun

 6. Dadansoddiad o’r Budd-ddeiliaid

Budd-ddeiliaid Diddordeb / budd Pwysigrwydd
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7. Dadansoddi risg

Risg Tebygolrwydd
(1- 5)

Difrifoldeb
(1- 5)

Sgôr
(T x D)

Gweithredoedd i 
rwystro / rheoli 

risg

8. Safonau

Enw’r safon Fersiwn Nodiadau

9. Hawliau eiddo deallusol

ADNODDAU

10. Partneriaid

11. Adnoddau ar gyfer digido
      staffio (gan gynnwys gwirfoddolwyr) ac offer

0
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CYNLLUN DIGIDO MANWL

12. Pecynnau gwaith

mis 1 2 3 4 5 6 7 8 9 10 11 12
Pecynnau 

gwaith
1
2
3
4
5
6
7
8
9
10

mis 1 = 

13. Gwerthusiad
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Pam ddim digido'r holl eitemau ar gydraniad 1200 ppi?

Ni all llygad dynol wahaniaethu rhwng delwedd sydd wedi'i sganio 300 ppi o'i 
chymharu â delwedd wedi'i sganio 1200 ppi ond fe fydd y ddelwedd 1200 ppi yn 
caniatáu i chi ei ehangu i argraffiad mwy heb golli ansawdd. Y newyddion drwg yw 
fod delwedd 1200 ppi yn ffeil llawer mwy o faint. Mae hyn yn broblem wrth storio 
ffeiliau.

Beth yw'r gwahaniaeth rhwng dpi a ppi?

ppi (square pixels per inch) – pan 
fyddwch yn chwyddo delwedd gellir gweld 
y picseli fel y gallwch weld yn y llun

Mae dpi (dots per inch) yn ymwneud â 
nifer y dotiau i'r fodfedd mewn 
argraffiad.

Pam fod du yn cael ei gynrychioli gan K yn CMYK?

Mae'r ‘K’ yn CMYK yn sefyll am ‘key’ oherwydd mewn argraffu pedwar lliw mae 
'cyan', 'magenta' a 'yellow' yn cael eu gosod yn ofalus gyda ‘key’ y ‘key plate’ du.

Beth yw'r gwahaniaeth rhwng trwydded ‘Comin Creadigol’ (Creative Commons) a 
Thrwydded Archif Greadigol?

Mae'r Drwydded Archif Greadigol wedi'i hysbrydoli gan y drwydded ‘Comin Creadigol’ 
(Creative Commons) ond mae'n cynnwys nodweddion ychwanegol sy'n ateb gofynion 
sefydliadau cyhoeddus yn y DU. Y ddau sy'n fwyaf amlwg yw'r gofynion 'DU yn unig' 
ac 'Dim Cefnogi' (No Endorsement). Mae'r Drwydded Archif Greadigol hefyd wedi'i 
chynllunio i ddiogelu hawl y Trwyddedwr i beidio â chael eu gwaith wedi’i drin mewn 
ffyrdd dirmygus neu atgas. 

http://www.bbc.co.uk/creativearchive/faqs.shtml
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Canllawiau Crëwr Prosiect InterPARES 2

www.interpares.org/display_file.cfm?doc=ip2(pub)creator_guidelines_booklet.pdf

Collections Link – the national collections management advisory service
www.collectionslink.org.uk

Strategic Content Alliance – IPR advice and publications
http://sca.jiscinvolve.org/ipr-publications/

JISC Digital Media (formerly TASI) – digitisation advice and training services
www.jiscdigitalmedia.ac.uk

Renaissance East Midlands Simple Digitisation Guide – pdf digitisation guide
www.renaissanceeastmidlands.org.uk/news_and_events/simple_guide_to.html

Dublin Core Metadata Initiative Usage Guide
www.dublincore.org/documents/usageguide

UKOLN – digital information management advice
www.ukoln.ac.uk

Creative Archive Licence
www.bbc.co.uk/creativearchive

Creative Commons Licence UK
www.creativecommons.org/international/uk

Darllen Pellach: 
Tim Padfield, Copyright for Archivists and Record Managers (3rd Ed.), London. 
2007.
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